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1. Getting Started
1.1 Office 2007 Environment

1.1.1 Ribbon

With the launch of Vista, Microsoft has taken the opportunity to update the look of its Office applications.  The most noticeable change is the replacement of pull-down menus and toolbars with the more intuitive and visual tab-based Ribbon.  All of the Office 2007 programs follow the same basic design, with some variations based on the particular functions of the program.

1.1.2 Tabs
Office applications automatically open to the Home command tab, which contains most of the features needed to create a basic document, such as font and paragraph settings.  Specialized features can be accessed from the other command tabs.

Tools for each command tab are divided into groups (e.g., the Clipboard, Font, and Number groups in Excel’s Home tab). Some command tabs are context-sensitive, displaying only when a particular feature is being used. For example, when a chart has been inserted into an Excel document, the Design, Layout, and Format tabs appear in the Ribbon.
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1.1.3 Office Button
The Office 2007 OFFICE BUTTON is located in the upper-left of the program window and is identified by the Office logo.  The OFFICE BUTTON allows you to open, save, and print documents, and perform other document output functions (e.g., fax and email). 
1.2 Opening Excel

NOTE: The procedure for opening Excel may vary depending on the setup of your computer.
1. From the Start menu, select Programs » Microsoft Office » Excel 2007 

2. Excel 2007 opens. 
1.3 Creating a Workbook

An Excel file is called a workbook. By default, workbooks open with three blank worksheets, although you can add or delete worksheets at any time. The advantage of having multiple worksheets, or layers, is that a variety of data can be compiled, analyzed, and integrated in a single file. Worksheets can contain data, charts, or both.  For more information on Excel terminology, refer to Appendix B: Worksheet Terms.
1. Under the Office Button, click New.
2. The New Workbook dialog box appears.
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3. Under Blank and recent, double click BLANK WORKBOOK 
A new workbook appears.
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1.3 Pointer Shapes

As with other Microsoft programs, the pointer often changes its shape as you work in Excel. Each pointer shape indicates a different mode of operation.  See Appendix A: Pointer Shapes for a list of Excel pointers and their functions.
1.4 Saving Your Work

1.4.1 Saving for the First Time

The following steps should be used when you are saving a worksheet for the first time, when you want to save it to a new location (e.g., as a backup), or when you want to save a copy with a different name.

1. In the top left corner of the Excel window, click the Office Button 

2. From the Office Button menu, select Save As...
OR
Press [Ctrl] + [S] 
The Save As dialog box appears.

3. From the Save in pull-down list, select the appropriate save location 

4. In the File name text box, type a filename
5. OPTIONAL: To save your workbook in a format other than the default (.xlsx), from the Save as type pull-down list, select the desired format
NOTE: This is an important consideration if you want your document to be able to open in Excel 97-2003.

6. Click SAVE
The file is saved. 

1.4.2 Saving Subsequent Times

1. In the top left corner of the Excel window, click the Office Button.
2. From the File menu, select Save
OR
Press [Ctrl] + [S]
OR
From the Quick Access toolbar, click SAVE [image: image3.png]



The file is saved.

2. Organizing Worksheets
Organizing the worksheets within your workbook files can make your Excel documents easier to maintain and manage. Worksheets can be moved, renamed, or deleted to make your workbook easy to navigate through. This document covers the following topics: 

2.1 Renaming Worksheet Tabs 

The tabs on the bottom of the worksheets contain the name of each worksheet. You can change the default name of the worksheet to describe its contents. 

1. To select the sheet name, double click the appropriate worksheet tab
OR
Right click the appropriate worksheet tab » select Rename 
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2. Type the new sheet name

3. Press [Enter] 
The worksheet is renamed. 
2.2 Changing Worksheet Tab Colors 

Coloring worksheet tabs can make specific worksheets easier to locate within a large workbook. 
1. Right click the appropriate SHEET tab » select Tab Color » select the desired color 
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2.3 Inserting Worksheets

New Excel workbooks are created automatically with three worksheets. If you need additional sheets, you can easily insert them.

2.3.1 Inserting Worksheets: Right Click Option 

This option inserts a new worksheet in front of the selected SHEET tab. 
1. Right click the appropriate SHEET tab » select Insert... 
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The Insert dialog box appears.

2. Select the General tab

3. Select Worksheet
4. Click OK 
The new worksheet is inserted in front of the current worksheet. 

2.3.2 Inserting Worksheets: Button Option

This option inserts a new worksheet after all other worksheets. 
1. At the far right of the worksheet tabs, click INSERT WORKSHEET[image: image7.png]



A new worksheet is added to the right of all other worksheets. 
2.4 Moving Worksheets

You may want your worksheets in a particular order when printing the final document. You may also want to group similar worksheets together, or simply rearrange the order for easier access while working on a file. If the original worksheet order no longer fits your needs, you can rearrange worksheets within the same workbook or move a worksheet to another workbook. 
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2.4.1 Moving Worksheets: Same Workbook, Right Click 

1. Right click the SHEET tab of the worksheet to be moved » select Move or Copy...
The Move or Copy dialog box appears.


2. From the To book pull-down list, select the current workbook

3. From the Before sheet scroll box, select where the sheet will be moved 
NOTE: The sheet will be placed in front of the sheet you select.

4. Click OK 
The worksheet is moved.

2.4.2 Moving Worksheets: Same Workbook, Drag and Drop Option

The Drag and Drop option works only if you want to move a worksheet within the same workbook. 

1. Click and hold the SHEET tab of the worksheet to be moved
A sheet icon and arrow appears.
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2. Drag the sheet icon to the desired location 
The arrow indicates where the sheet will be placed.

3. Release the mouse button
The worksheet is moved.

2.4.3 Moving Worksheets: Different Workbook
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Open both the worksheet to be moved and the workbook to which it will be moved

2. To display the worksheet that will be moved, 

a. From the Ribbon, select the View command tab

b. In the Window group, click SWITCH WINDOWS » select the workbook containing the worksheet to be moved 

3. Right click the SHEET tab of the worksheet to be moved » select Move or Copy...
The Move or Copy dialog box appears.


4. To move the worksheet to an existing workbook, from the To book pull-down list, select the destination workbook 
To move the worksheet to a new workbook, from the To book pull-down list, select (new book)
5. From the Before sheet scroll box, select where the sheet will be moved 
NOTE: The sheet will be placed in front of the sheet you select.

6. Click OK 
The worksheet is moved. 
2.5 Copying Worksheets

You may need to create a copy of a worksheet if the same information is needed in multiple files. Or, you may want to use the same format without having to reformat a new worksheet. For example, if you have created a worksheet for one project but do not want to recreate the worksheet for another project, copying the worksheet saves you the time of creating another worksheet.
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2.5.1 Copying Worksheets: Same Workbook

1. Right click the SHEET tab of the worksheet to be copied » select Move or Copy...
The Move or Copy dialog box appears.


2. In the To book pull-down list, select the current workbook 

3. From the Before sheet scroll box, select where the sheet will be located 
NOTE: The sheet copy will be placed in front of the sheet you select. 

4. Select Create a copy
5. Click OK 
The worksheet is copied. 

6. OPTIONAL: Rename the copy

2.5.2 Copying Worksheets: Different Workbook
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Open the worksheet to be copied and the workbook to which it will be copied 

2. To display the worksheet that will be moved, 

a. From the Ribbon, select the View command tab

b. In the Window group, click SWITCH WINDOWS » select the workbook containing the worksheet to be moved 

3. Right click the SHEET tab of the worksheet to be copied » select Move or Copy...
The Move or Copy dialog box appears.


4. To copy the worksheet into an existing workbook, from the To book pull-down list, select the destination workbook
To copy the worksheet into a new workbook, from the To book pull-down list, select (new book)
5. From the Before sheet scroll box, select where you want the worksheet copied 
NOTE: The sheet copy will be placed in front of the sheet you select. 

6. Select Create a copy
7. Click OK 
The worksheet is copied.

2.6 Deleting Worksheets

If you no longer have a need for a particular worksheet, you can delete that sheet from the workbook. 

1. Right click the appropriate SHEET tab » select Delete
The sheet is deleted. 

2.7 Grouping Worksheets

Grouping your worksheets can help improve consistency and save time. Once sheets are grouped, you can format or print the entire group.

1. Click the SHEET tab of the first sheet to be grouped 
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2. To select non-contiguous sheets, press [Ctrl] + click the sheets to be grouped 
To select contiguous sheets, press [Shift] + click the last sheet to be grouped 

3. When all the sheets of the group are selected, release the [Shift] or [Ctrl] key 
The selected worksheets are grouped. 
NOTES:
The tabs of the grouped sheets will appear white. Unselected sheets' tabs will remain unchanged (colors may differ based on your windows color scheme).
The notation [Group] appears next to the filename.
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2.8 Ungrouping Worksheets

When you are finished working with your sheet groups, you will need to ungroup them.

2.8.1 Ungrouping Worksheets: All Sheets
1. Right click one of the SHEET tabs within the group » select Ungroup Sheets
All grouped worksheets are ungrouped. 

2.8.2 Ungrouping Worksheets: Individual Sheets 

1. Press [Ctrl] + click the SHEET tab of the sheet to be removed from the group 
The selected worksheet is removed from the group.
2.9 Formatting Worksheet Groups

If you have multiple sheets within your workbook that require the same formatting, you can format all worksheets within a group at the same time. This option works when the worksheets have similar information in the same relative location. Many types of formatting can be done with sheet groups:

· Column width

· Shading

· Formulas and functions

· Borders

To format groups of sheets, use the following instructions:

1. Group the worksheets 

2. On the current worksheet, select the cell(s) to be formatted 

3. Using the Formatting toolbar or the Format menu, apply the appropriate formatting
NOTE: For more information about formatting options, refer to Formatting Cells on page 17. 

4. Repeat steps 2–3 as necessary

5. Ungroup the worksheets 

3. Entering Data
3.1 Entering Text 

Excel allows you to enter text into cells. 

1. Select the cell where you want to enter text 

2. Type text into the cell

3. To accept the text, press [Enter] or an [Arrow]
To force text to wrap at a specific point in a cell, press [Alt] + [Enter] 

3.2 Entering Numbers 

Numeric cells can be used for calculations and functions. A numeric cell may contain numbers, a decimal point (.), plus (+) or minus (-) signs, and currency ($).

1. Select the cell where you want to enter numbers 

2. Type the numeric information that should be in the cell
HINT: To enter a fraction, type 0 and press [Space] before the fraction; otherwise, Excel will interpret the fraction as a date.

3. To accept the information, press [Enter] or an [Arrow] 
NOTES: 
Excel automatically right-aligns numerical values and left-aligns text.
Do not include spaces or alphabetical characters in a calculation cell.
3.3 Entering Numbers Formatted as Text 

When cells are formatted for text, all cell contents—letters, numerals, or alpha-numeric combinations—are treated as text. Information is displayed exactly as it is entered. There are two ways to enter numbers as text. 

3.3.1 Entering Numbers Formatted as Text: Apostrophe Character
1. Select the cell you want to enter information into

2. Press ['], then type numeric information 

3. To accept the information, press [Enter] or an [Arrow]

3.3.2 Entering Numbers Formatted as Text: Dialog Box 

NOTE: This method is especially useful when formatting multiple cells to display text.

1. From the Ribbon, select the Home command tab

2. In the Number group, click FORMAT CELLS [image: image11.png]



The Format Cells dialog box appears. 

3. Select the Number tab 

4. From the Category scroll list, select Text 
5. Click OK 

6. Type the desired numbers and/or text in the cell

7. To accept the text, press [Enter] or an [Arrow]
To force text to wrap at a specific point in a cell, press [Alt] + [Enter] 

3.4 Entering Dates and Times

3.4.1 Entering a Date and Time Manually
1. Select the cell where you want to enter the date or time

2. To enter a date, type the date in one of the following formats: 8/14/2006, 8-14-2006, or August 14, 2006

3. To enter a time 

a. Type the time

b. Press [Space]

c. To indicate AM or PM, press [Shift] + [A] or [P], respectively

4. To accept the information, press [Enter]

3.5 Entering the Current Date and Time: Dynamic

Excel offers several ways to include dates and times into your worksheets. Depending on the purpose of your worksheet, you will need to decide whether to insert a static or dynamic date and time. Static dates and times will not change as you work with your worksheet, while dynamic dates and times will change as time progresses and modifications are made to your worksheet.

Dynamic dates and times are updated every time Excel recalculates, which is, by default, every time [Enter] is pressed. This is useful if you would like the current date and/or time to be displayed every time the worksheet is viewed or printed.

3.5.1 Inserting a Dynamic Date Only
1. Select the cell in which you want the date to appear

2. In the cell, type =today()
3. Press [Enter] 
The current date appears in the cell and will be updated every time Excel recalculates. 

3.5.2 Inserting a Dynamic Date and Time
1. Select the cell in which you want the date and time to appear

2. In the cell, type =now()
3. Press [Enter] 
The current date and time appear in the cell and will be updated every time Excel recalculates. 
3.6 Entering the Current Date and Time: Static
Static dates and times are not updated. The date or time that is inserted into the cell will be the date or time that the command is entered into the cell.

3.6.1 Inserting a Static Date
1. Select the cell in which you want the date to appear

2. Press [Ctrl] + [;] 
The current date appears in the cell and will not be updated.

3.6.2 Inserting a Static Time
1. Select the cell in which you want the time to appear
Press [Ctrl] + [Shift] + [:] 
The current time appears in the cell and will not be updated. 
3.7 Using the Fill Command

The Fill command allows you to repeat or continue information in contiguous cells without copying the information manually. With this option, if the first cell contains a formula, the formula will be repeated in the additional cells, and if the first cell contains text, the text will be repeated in the additional cells. If Excel recognizes a pattern of information, the additional cells will contain the next item in the pattern (e.g., if the selected cells are numbered from one to five, the next cell would contain six; other examples include filling months of the year and hours of the day). You can allow Excel to automatically fill in the information for you, or you may choose to create custom patterns of information.

3.7.1 Filling Cells: Ribbon Option

This option copies (repeats) the information from one cell to another. To extend the series, refer to the mouse option below.

1. Type the information (cell contents or formula) in the first cell of the group 

2. Starting with the cell containing the contents to be copied, select the group of cells to be filled 

3. From the Ribbon, select the Home command tab

4. In the Editing group, click FILL [image: image12.png]9~



 » select the appropriate option:

a. Down:  Repeats the contents of the first cell throughout the selected cells below it.

b. Right:  Repeats the contents of the first cell throughout the selected cells to the right of it.

c. Up:  Repeats the contents of the first cell throughout the selected cells above it.

d. Left:  Repeats the contents of the first cell throughout the selected cells to the left of it.

e. Across Worksheets:  Repeats the contents of the selected cells in another selected worksheet.

f. Series...:  Fills in data that is part of a pattern, rather than simply repeating the data across selected cells. This option brings up the Series dialog box, which allows you to select the type of pattern you would like to use. 
EXAMPLE: If the first cell contains the day Sunday, Excel will fill the following cells with Monday, Tuesday, etc. 

g. Justify:  Distributes text in the first selected cell throughout several selected rows.
NOTE: This option changes the contents of these cells by moving the data to fit within the new rows.

5. OPTIONAL: If you selected the Series option
In the Series dialog box, select the desired options: 

a. Series in:  Determines whether the additional information will appear in a vertical line (rows) or in a horizontal line (columns).

b. Type:  Determines whether the additional information will differ from the previous entry by a specific interval (Linear), by multiplying the previous entry by a specific value (Growth), by creating a series of dates according to the selected date format (Date), or by automatically detecting what type of fill you would like to apply (AutoFill). 

c. Date Unit:  When Date is selected as the type, determines whether numbers are listed for each day (Day) for each day in the weekday (Weekday), for that day of every month (Month), or for that day of every year (Year).

d. Trend:  When Linear or Growth is selected as the type, calculates the average difference between values existing in selected cells and uses that difference to calculate the fill values. 

e. Step Value:  When Linear or Growth is selected as the type, determines the amount that the previous value is added to or multiplied by to come up with the results for the next cell. When Date is selected as the type, it determines how many dates should be skipped between each recorded value. 

f. Stop Value:  Determines a value at which the series should no longer be continued. 

6. Click OK. The fill is applied. 

3.7.2 Filling Cells: Mouse Option

Using this option will extend the data in the series to the selected cells.
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Type the information (cell contents or formula) in the first cell of the group 

2. In this cell, move your pointer over the fill corner so your pointer changes into crosshairs [image: image13.png]



NOTE: For this option to work, you must ensure that the pointer changes into a crosshairs before filling. 

3. Click and hold the crosshairs 

4. Drag the mouse in the direction you want the information to be copied
NOTES: You can drag the corner in any one direction; left, right, up, or down. 

5. Release the mouse button
The fill is applied.

3.8 Working with Custom Fills 

Custom fills allow you to select what information you want repeated. For example, if you typed the names of terms for a college with quarters (Fall, Winterim, Spring, and Summer) several times, custom fills allow you to automate the process. Using the regular Fill function, Excel would repeat "Fall" in all selected cells. With a custom fill, when you type Fall and use the Fill command, Winterim, Spring, and Summer will be entered in the adjacent cells. This feature is also handy when using Excel to create a grade book. For example, you could create a custom fill for letter grades (e.g., A, A-, B+, B, B-, ..., F).
Custom fills can be created from scratch or from an existing section of your worksheet. After creation, Excel will automatically apply your custom fills when using the AutoFill function. 

NOTES:
Custom fills will work consistently only with word lists. 

Lists of values do not work consistently.  

3.8.1 Creating a Custom Fill 

1. From the Office Button menu[image: image14.png]


, click EXCEL OPTIONS[image: image15.png]2 Excel Options.



 
The Excel Options dialog box appears. 

2. From the Categories list, select Popular
The dialog box refreshes to show the Popular options. 

3. In the Top options for working with Excel section, click EDIT CUSTOM LISTS...
The Custom Lists dialog box appears. 
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4. In the Custom lists scroll box, select NEW LIST 

5. In the List entries text box, type the information you want to be added in the custom fill, pressing [Enter] after each entry 
EXAMPLE: A, A-, B+, B, B-, ..., F 
NOTE: Be sure to type every unit in the order you want it to appear. 
[image: image17.png]Custom Lists

comom s |

Custom s [
A B

S o, T, Wed, i, 1 [A-
Sy, My, sy, W[5+ .

5o, Fob, i, B, oy, i, - g

oy, February, Ve, Ao [e-

o

5

<

o

o

e

e

PressEner toseprate st et
Import st from cels: T B me
Corce






6. Click ADD 
Your new entries appear in the Custom Lists scroll list. 

7. Click OK
The Custom Lists dialog box closes. 

8. Click OK 
The Excel Options dialog box closes. 

3.8.2 Importing Custom Fills 

If you have a group of cells that contains information you would like to repeat elsewhere, you can create a custom fill from them.

1. Select the group of cells with the information you want to make into a custom fill 

2. From the Office Button menu[image: image18.png]


, click EXCEL OPTIONS[image: image19.png]2 Excel Options.



 
The Excel Options dialog box appears. 

3. From the Categories list, select Popular
The dialog box refreshes to show the Popular options. 

4. In the Top options for working with Excel section, click EDIT CUSTOM LISTS...
The Custom Lists dialog box appears. 
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5. Click IMPORT
Your selection appears in the List entries text box.
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6. Click OK
The Custom Lists dialog box closes. 

7. Click OK 
The Excel Options dialog box closes. 
3.8.3 Using a Custom Fill 

1. To use your custom fill, place the cell pointer in any cell and type the first entry
EXAMPLE: Type A 
HINT: If you have created several custom fills that begin with the same entry, you may need to type the first two entries in the first two cells in order for Excel to know which fill you want to use. 
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In this cell, move your pointer over the fill corner so your pointer changes into crosshairs[image: image22.png]



NOTE: For this option to work, you must ensure that the pointer changes into a crosshairs before filling. 

3. Click and hold the crosshairs

4. Drag the corner in the direction you want the information to be copied 
NOTE: For more information about filling cells, refer to 3.7.2 Filling Cells: Mouse Option.
5. Release the mouse button
The cells will be filled with the information you provided. 

4. Editing Cell Contents

After creating part of an Excel worksheet, you may discover that the information needs to be changed, moved, or repeated. Excel allows you to edit cell contents in a variety of ways that can make creating your document easier. Functions and formulas can be copied or moved, lists can be automatically continued, and formulas can be applied to different data.

4.1 Moving Information

Often, your first approach at organization will not be the same as your final ideas. For this reason, you may want to reorganize information. You may also want to duplicate an established formula for use in another cell. The Drag and Drop, Cut and Paste, and Copy and Paste options will help you do this without having to recreate the entire worksheet.

4.1.1 Drag and Drop vs. Cut and Paste

Drag and Drop allows you to move the information from a single cell or a range of cells. Drag and Drop is great for moving short distances but challenging for moving to cells not displayed on the current screen. Cut and Paste is the better method when moving information over long distances.

4.1.2 Moving Information: Drag and Drop 

Formulas using relative cell references are automatically updated when the cells they are referring to are moved using the Drag and Drop method. 
NOTE: Be sure to check the references; one accidental absolute reference can alter the end result of the calculation.
For information on relative and absolute cell references, see 7.3 Cell References: Relative and Absolute.

1. Select the cell(s) to be moved 
HINTS:
To select an individual cell, click that cell.
To select multiple contiguous cells, click and drag across the desired cells. 

2. Point to the heavy border surrounding the cell(s)
[image: image23.png]



The cursor changes to a four-headed arrow[image: image24.png]


. 

3. Click and hold the mouse button 

4. Drag the cell(s) to the new location
NOTE: An outline of the cell(s) you are moving will appear over the new location. As you move the cell(s), a box appears next to the pointer, indicating the cell location. 

5. When you reach the desired location, to drop the cell(s), release the mouse button
The cell(s) are inserted into the selected location. 
WARNING: If information already exists at the new location, a dialog box will appear to confirm that you want to replace the information.

4.1.3 To Undo Drag and Drop:

1. On the Quick Access toolbar, click UNDO [image: image25.png]



OR
Press [Ctrl] + [Z] 

4.1.4 Moving Information: Cut and Paste 

Formulas using relative cell references are automatically updated when the cells they are referring to are moved using the Cut and Paste method. Be sure to check the cell references after pasting; if even one accidental absolute reference is contained in your formulas, the results of your calculation could be altered.  See 7.3 Cell References: Relative and Absolute for more information.
1. Select the cell(s) to be moved 
HINTS: 
To select an individual cell, click that cell.
To select multiple contiguous cells, click and drag across the desired cells. 

2. Press [Ctrl] + [X]
OR 

a. From the Ribbon, select the Home command tab

b. In the Clipboard group, click CUT [image: image26.png]



A moving border appears around your selection.

3. Select the cell where you want the cell(s) to be pasted

4. Press [Ctrl] + [V] 
OR 

a. From the Ribbon, select the Home command tab

b. In the Clipboard group, click PASTE [image: image27.png]


 
The information is pasted. 

4.2 Copying Formulas

Copying formulas works differently than moving formulas. When copying formulas, you must be aware that some types of cell references will update to reflect information for the new location, while some will continue to use the original information. 

When copying formulas, correct cell references are especially important to the result of the formula. Formulas that are copied to a new location can use either relative or absolute cell references (see See 7.3 Cell References: Relative and Absolute). If you want to copy the formula and look at cells with similar information one column over, a relative formula is the best choice. However, if you want to copy the formula and refer to the same cell (perhaps the wage rate of a student employee), you should be working with an absolute formula, not a relative formula.

NOTE: Absolute references are automatically updated for column and row additions and deletions.
	Example
	Description

	=A12+B12
	Formula with relative references

	=$A$12+$B$12
	Formula with absolute references

	=$A12+$B12
	Formula with absolute column references and relative row references

	=A$12+B$12
	Formula with absolute row references and relative column references


4.2.1. Copy and Paste 

Copy and Paste works well for duplicating formulas, values, and labels without reentering them. The process for copying information in Excel is similar to copying in Word or other Windows applications. For another option to copy cell information, refer to 3.7 Using the Fill Command.
1. Select the cell(s) to be copied 
HINTS:
To select an individual cell, click that cell.
To select multiple contiguous cells, click and drag across the desired cells. 

2. Press [Ctrl] + [C] 
A moving border appears around your selection.
OR 

a. From the Ribbon, select the Home command tab

b. In the Clipboard group, click COPY [image: image28.png]


 
A moving border appears around your selection. 

3. Select the cell where you want the copied cells to be pasted 

4. Press [Ctrl] + [V] 
The information is pasted. 
OR 

a. From the Ribbon, select the Home command tab

b. In the Clipboard group, click PASTE [image: image29.png]


 
The information is pasted. 

5. To deselect the copied cells, press [Ctrl] + [D]
OR
Press [Esc] 

5. Formatting Cells
In Excel, every cell can be formatted differently. There are many options available to customize your Excel workbook, which can make the worksheet easier to read. Excel also provides many number formats, allowing you to standardize how numbers will appear in your document. For more information, refer to 6.4 Formatting Numbers. 
5.1 Changing Cell Alignment 
Using the Alignment tools, you can determine how your data will appear in a cell.  You can change the vertical and horizontal alignment, indent the data, or even have it appear at an angle.

5.1.1 Changing Cell Alignment: Ribbon Option
1. Select the cell to be formatted 

2. From the Home command tab, in the Paragraph group, click the appropriate text alignment button
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5.1.2 Changing Cell Alignment: Menu Option
1. Select the cell to be formatted 
2. From the Home tab, in the Format group, click ALIGNMENT [image: image31.png]



The Alignment dialog box appears. 
3. Select the alignment and orientation options you want.

4. Click OK.
5.2 Applying Cell Styles 

Cell Styles are a combination of fill and font color designed to highlight or emphasize cell contents. They are easily applied to your workbook. 
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1. Select the cell(s) whose style you want to change 

2. From the Home command tab, in the Styles group, click CELL STYLES

A pull-down list appears.

NOTE: When you hover your mouse over different styles, a preview of the style will appear in the selected cells.

3. From the Good, Bad and Neutral; Data and Model; or Titles and Headings group, select the desired cell style.  The style is applied to the selected cells.

5.3 Merging Cells 

A cell merge converts selected cells into a single cell. This can be useful for creating titles.

5.3.1 Creating a Cell Merge 

WARNING: After a cell merge, if two or more selected cells have data in them, Excel will display the information from the cell closest to the upper left corner, deleting all other data.

1. Select the cells you want to merge

2. From the Home command tab, in the Alignment group, click MERGE & CENTER[image: image32.png]= Merge & Center -~




The cells are merged and the text aligns to the center 

5.3.2 Customizing a Cell Merge 
1. Select the cells you want to merge

2. Click the [image: image33.png]


 next to MERGE & CENTER
A pull-down list appears.

3. To merge cells and align text to the center, click MERGE & CENTER
To merge cells only as rows (i.e., columns do not merge), click MERGE ACROSS
To merge cells without setting an alignment, click MERGE CELLS
5.3.3 Removing a Cell Merge 
1. Select the cell you want to unmerge

2. Click the [image: image34.png]


 next to MERGE & CENTER » select Unmerge Cells
The cell merge is removed. 

5.4 Adjusting Row Height and Column Width

When you start working on a worksheet, all columns are 8.43 characters wide (in default font) and row heights are set to fit the content of the cell with a maximum of 15 points. Excel may widen the column or increase the row height to fit the cell content. Adjusting the width or height is easy to do and can be done using the Ribbon option or the Mouse option.

Since columns and rows extend throughout the worksheet, the setting applies to the entire column or row. If you need to have two settings, you will have to move some of your information to another row or column with the correct settings. 

5.4.1 Adjusting Row Height: Ribbon Option
1. To adjust a single row, select any cell from the row to be adjusted
To adjust multiple non-contiguous rows, press [Ctrl] + select cells from each row to be adjusted 

2. From the Ribbon, select the Home command tab 

3. In the Cells group, click FORMAT[image: image35.png]&) Format ~




4. In the Cell Size section, select Height... 
The Row Height dialog box appears.
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5. In the Row height text box, type the desired height 

6. Click OK 
The row height is adjusted. 

5.4.2 Adjusting Row Height: Mouse Option

If you choose to adjust multiple rows at once, all selected rows will be adjusted the same amount no matter which row border you move. 

1. To adjust multiple non-contiguous rows, press and hold [Ctrl] while clicking the ROW ID for each desired row
To adjust multiple contiguous rows, press and hold [Shift] while clicking the first and last ROW ID for the desired range

2. Along the row ID (e.g., 1, 2, 3, ...), point to the border below the row to be adjusted 

3. When the pointer turns into a double-arrow, click and drag 
HINT: For a shorter row, drag up; for a taller row, drag down.
A box appears next to the pointer, indicating the current row height as you drag it. 
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4. When the row reaches the desired height, release the mouse button 
The row height is adjusted. 

5.4.3 Adjusting Column Width: Ribbon Option
1. To adjust a single column, select any cell from the column to be adjusted
To adjust multiple non-contiguous columns, press [Ctrl] + select cells from each column to be adjusted 

2. From the Ribbon, select the Home command tab 

3. In the Cells group, click FORMAT[image: image38.png]&) Format ~




4. In the Cell Size section, select Width... 
The Column Width dialog box appears.
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5. In the Column width text box, type the desired width 

6. Click OK 
The column width is adjusted. 

5.4.4 Adjusting Column Width: Mouse Option

If you choose to adjust multiple columns at once, all selected columns will be adjusted the same amount no matter which column border you move. 

1. To adjust multiple non-contiguous columns, press and hold [Ctrl] while clicking the COLUMN ID for each desired row
To adjust multiple contiguous columns, press and hold [Shift] while clicking the first and last COLUMN ID for the desired range

2. Along the column ID (e.g., A, B, C, ...), point to the border right of the column to be adjusted 

3. When the pointer turns into a double-arrow, click and drag 
HINT: For a narrower column, drag left; for a wider column, drag right. 
A box appears next to the pointer, indicating the current column width as you drag it. 
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4. When the column reaches the desired width, release the mouse button 
The column width is adjusted. 

5.5 Using AutoFit to Adjust Rows and Columns

To adjust the column width or the row height, Excel can determine the best width and height based on the information in the column or row.

5.5.1 Using AutoFit to Adjust Row Height: Mouse Option
1. Along the row ID (e.g., 1, 2, 3, ...), point to the border below the row to be adjusted 

2. When the pointer turns into a double-arrow, double click
The row height adjusts so the tallest item in the row is displayed in full. 
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5.5.2 Using AutoFit to Adjust Row Height: Ribbon Option
1. To select a row to be adjusted, click the ROW ID (e.g., 1, 2, 3, ...)
The entire row is selected. 

2. From the Ribbon, select the Home command tab 

3. In the Cells group, click FORMAT[image: image41.png]&) Format ~




4. In the Cell Size section, select AutoFit 
The row height adjusts so the tallest item in the row is displayed in full. 

5.5.3 Using AutoFit to Adjust Column Width: Mouse Option
1. Along the column ID (e.g., A, B, C, ...), point to the border right of the column to be adjusted 

2. When the pointer turns into to a double-arrow, double click
The column width adjusts so the widest item in the column is displayed in full. 

5.5.4 Using AutoFit to Adjust Column Width: Ribbon Option
1. To select a column to be adjusted, click the COLUMN ID (A, B, C, ...)
The entire column is selected. 

2. From the Ribbon, select the Home command tab 

3. In the Cells group, click FORMAT[image: image42.png]&) Format ~




4. In the Cell Size section, select AutoFit Selection 
The column width adjusts so the widest item in the column is displayed in full. 

5.6 Adding and Removing Rows and Columns

When working with worksheets, you will often need to make changes to the original worksheets, such as deleting old information or adding new information. To make this task easier, you can add new rows and columns or delete existing rows and columns.

5.6.1 Adding Rows
1. Select a cell below where you want to add a new row

2. From the Ribbon, select the Home command tab

3. In the Cells group, click the arrow[image: image43.png]


on the INSERT button » select Insert Sheet Rows
A new row is added above the selected cell. 

5.6.2 Adding Columns
1. Select a cell to the right of where you want to add a new column 

2. From the Ribbon, select the Home command tab

3. In the Cells group, click the arrow[image: image44.png]


on the INSERT button » select Insert Sheet Columns 
A new column is added left of the selected cell. 

5.6.3 Deleting Rows

WARNING: When you delete a row, everything in the row is deleted. If you do not want to delete the whole row, delete information from specific cells instead.

1. To delete a single row, select any cell from the row to be deleted 
To delete multiple non-contiguous rows, press [Ctrl] + select the cells from each row to be deleted 

2. From the Ribbon, select the Home command tab

3. In the Cells group, click the arrow[image: image45.png]


on the DELETE button » select Delete Sheet Rows
The row(s) are deleted. 

5.6.4 Deleting Columns

WARNING: When you delete a column, everything in the column is deleted. If you do not want to delete the whole column, delete information from specific cells instead.

1. To delete a single column, select any cell from the column to be deleted 
To delete multiple non-contiguous columns, press [Ctrl] + select the cells from each column to be deleted 

2. From the Ribbon, select the Home command tab

3. In the Cells group, click the arrow[image: image46.png]


on the DELETE button » select Delete Sheet Columns 
The column(s) are deleted. 
5.7 Wrapping Text

If you have text that appears in a single cell and you want to increase the height of the cell without expanding the row or column, you can use the Wrap text option.

1. Select the appropriate cells 

2. From the Home command tab, in the Alignment group, click WRAP TEXT[image: image47.png]



The text wrap is applied.
NOTE: To remove the text wrap, click WRAP TEXT again.

5.8 Formatting Borders 

To make certain cells stand out in the worksheet, you may want to format a cell's borders.

5.8.1 Changing Borders
1. Select the cell(s) whose borders you want to format

2. From the Home command tab, in the Font group, click the [image: image48.png]


 next to BORDER [image: image49.png]


 and select the desired border.  The border is applied.

5.8.2 Changing Border Color
1. From the Home command tab, in the Font group, click the [image: image50.png]


 next to BORDER [image: image51.png]


 » select Line Color » select the desired color.
The cursor changes to the shape of a pencil. 

2. To format individual borders, click the borders you want changed
To format multiple cells, click and drag across the desired cells 

3. To quit formatting border colors, press [Esc]

5.8.3 Changing Border Style 
1. From the Home command tab, in the Font group, click the [image: image52.png]


 next to BORDER [image: image53.png]


 » select Line Style » select the desired line style

2. To format individual borders, click the borders you want changed
To format multiple cells, click and drag across the desired cells 

3. To quit formatting border styles, press [Esc]

5.8.4 Deleting Borders 
1. From the Home command tab, in the Font group, click the [image: image54.png]


 next to BORDER [image: image55.png]


 and select Erase Border
The cursor changes to the shape of an eraser. 

2. To delete individual borders, click the borders you want changed
To delete multiple cell borders, click and drag across the desired cells 

3. To quit deleting borders, press [Esc]
5.9 Copying Cell Formatting

The typical copy and paste functions will copy text and all associated formatting; however, if you want to copy only the formatting, you can use the Format Painter. The Format Painter will format the destination text the same as the source text but will not copy or paste any actual text.

5.9.1 Using the Format Painter: One Application 

This method allows you to apply formatting to one instance of contiguous text.

1. Highlight the text containing the desired formatting

2. From the Home command tab, in the Clipboard group, click FORMAT PAINTER[image: image56.png]# Format Painter




The pointer changes shape to include a paintbrush. 

3. Highlight the desired text to be formatted
OR
Click the desired word to be formatted 
The format you copied is applied to that text.

5.9.2 Using the Format Painter: Multiple Applications

This method allows you to apply formatting to non-contiguous text.

1. Highlight the text containing the desired formatting

2. From the Home command tab, in the Clipboard group, double click FORMAT PAINTER[image: image57.png]# Format Painter




The pointer changes shape to include a paintbrush. 

3. Highlight the desired text to be formatted
OR
Click the desired word to be formatted 
The format you copied is applied to that text.

4. Repeat step 4 until all additional text is formatted

5. When finished, to turn off the Format Painter, press [Esc] 
OR
Click FORMAT PAINTER [image: image58.png]# Format Painter





5.10 Clearing Cell Formatting 

You can remove all cell formatting while preserving text formatting in selected cells (e.g., fill color, alignment, and borders will be cleared, but text color, font size, and font face will not be cleared).

1. Select the cell(s) containing the formatting to be cleared

2. From the Home command tab, in the Editing group, click CLEAR [image: image59.png]2 Clear ~



 » select Clear Formats
The cell formatting is removed. 

5.11 Sorting Data 

The Sort command arranges worksheet data by text (i.e., A to Z, Z to A), numbers (i.e., smallest to largest, largest to smallest), dates, or times (oldest to newest, newest to oldest). This document shows you how to sort your Excel 2007 worksheet data.

5.11.1 Sorting Data: Sort Button 

If you simply want to sort your data by one column from smallest to largest or largest to smallest, you can do so with one click.

1. Select a cell in the column used to sort

2. From the Data command tab, in the Sort & Filter group, click SORT SMALLEST TO LARGEST[image: image60.png]


or SORT LARGEST TO SMALLEST[image: image61.png]



The selected column is sorted.

5.11.2 Sorting Data: Sort Dialog Box 

Using the Sort dialog box, you can create multi-level sorts that meet a variety of specifications. 

1. Select a cell in the column you want to use to sort 

2. From the Data command tab, in the Sort & Filter group, click SORT[image: image62.png]Sort




The Sort dialog box appears.
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3. To sort by ascending or descending values (i.e., alphabetically, numerically, time, or date) 

a. In the Sort by pull-down list, select the column you want to use to sort

b. In the Sort On pull-down list, select Values
c. In the Order pull-down list, select A to Z or Z to A
The data is sorted according to the selected order.

4. To sort according to a custom list 

a. In the Sort by pull-down list, select the column you want to use to sort
EXAMPLE: select a column containing days of the week 

b. In the Sort On pull-down list, select Values
c. In the Order pull-down list, select Custom List...
The Custom Lists dialog box opens

d. Select the custom list by which you want to sort
EXAMPLE: select Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday 
5. To sort according a formatting criterion

a. In the Sort by pull-down list, select the column you want to use to sort

b. In the Sort On pull-down list, select the appropriate option
EXAMPLE: Select Cell Color 
c. In the Order pull-down list, select a color and appropriate sort order
EXAMPLE: select Blue and On Top
6. OPTIONAL: To sort by more than one column

a. Click ADD LEVEL[image: image64.png]


 
b. In the Then by row of the Sort dialog box, select the additional sort options 

7. OPTIONAL: To control how to sort lists of days or months, case-sensitive data, and orientation 

a. Click OPTIONS... 
The Sort Options dialog box appears.
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b. Make necessary changes

c. Click OK 

8. Click OK
The data is sorted. 

6. Formatting Data: Text and Numbers
6.1 Formatting Text

Some rules to remember when formatting your text include the following:

· If you know what formatting options you want, you can enable them before you type. After you finish typing the section, you can disable them.

· When formatting text that is already typed into the document, the first step is to select it. Only selected text will take on the format that you are applying.

· Using too many fonts, sizes, and other formatting in one document often looks cluttered and is hard to read. Try to limit yourself to no more than two or three fonts, sizes, and formats per document.

· Once the text is formatted, deselect the text by clicking away from the text or pressing an arrow key. Selected text is vulnerable and may be deleted or changed unintentionally.

6.2 Changing Font, Size, and Color 

Excel allows you to change the font, size, and color from the Ribbon, the Font dialog box, or the Contextual toolbar. The Ribbon and Contextual toolbar options are easier and faster ways of changing the look of your text. However, the Font dialog box provides more options and allows you to preview your text through the Preview box.

6.2.1 Changing Font, Size, and Color: Ribbon Option
1. Select the desired text

2. [image: image160.png]


From the Home tab, in the Font group, from the Font pull-down list, select the desired font
NOTE: As you hover your mouse over a font, Word previews it live on your selected text. 

3. To select a different size, from the Font Size pull-down list, select the desired font size 
[image: image66.png]



4. To select a different color, click the[image: image67.png]


next to FONT COLOR [image: image68.png]


» select the desired font color

6.2.2 Changing Font, Size, and Color: Contextual Toolbar Option
1. Select the desired text
The Contextual toolbar appears above the text.
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2. To select a different font, from the Font pull-down list, select the desired font

3. To select a different size, from the Font Size pull-down list, select the desired font size

4. To select a different color, click the[image: image70.png]


next to FONT COLOR [image: image71.png]


» select the desired font color

6.2.3 Changing Font, Size, and Color: Menu Option
1. [image: image161.png]|
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Select the desired text

2. From the Home tab, in the Font group, click FONT[image: image72.png]



The Font dialog box appears.
NOTE: A preview and description of the selected font appear in the Preview section. 

3. In the Font text box, type the desired font name
OR
From the Font scroll list, select the desired font

4. In the Size text box, type the desired font size
OR 
From the Size scroll list, select the desired size

5. From the Font color pull-down list, select the desired font color 

6. In the Effects section, select any additional font effects
EXAMPLES: Small caps, Superscript, Subscript
7. Click OK
6.3 Changing Character Formatting

Word allows you to format text characters using the Ribbon, Contextual toolbar, menu, or keyboard options. The Ribbon, Contextual toolbar and keyboard options are faster; however, the menu option offers more options. Some of the styles you can apply are boldface, italics, underlining, shadow, superscript or subscript, single or double strikethrough, small or all caps, and color.

6.3.1 Changing Character Formatting: Ribbon Option
1. Select the text to be formatted 

2. From the Home tab, in the Font group, click the appropriate formatting buttons
HINT: To deselect character formatting, select the text and click the formatting button a second time. 
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6.3.1 Changing Character Formatting: Contextual Toolbar Option
1. Select the text to be formatted
The Contextual toolbar appears on top of the text.
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2. On the Contextual toolbar, click one or more of the appropriate formatting buttons
HINT: To deselect character formatting, select the text and click the formatting button a second time.

6.3.2 Changing Character Formatting: Menu Option
1. Select the text to be formatted

2. From the Home tab, in the Font group, click FONT[image: image75.png]



The Font dialog box appears.

3. In the Font style text box, type the desired style
OR
From the Font style scroll list, select the desired style

4. If necessary, in the Effects section, select additional formatting options 
EXAMPLE: Small caps, Shadow
5. Click OK 
6.3.3 Changing Character Formatting: Keyboard Option
1. Select the text to be formatted 

2. Press the appropriate key(s): 
	Enhancement
	Keystroke

	Italics
	[Ctrl] + [I]

	Bold
	[Ctrl] + [B]

	Underline
	[Ctrl] + [U]


6.4 Formatting Numbers 

Excel provides preset number formats to help you standardize how numbers will appear in your worksheet. You may also customize number formats to fit your needs.
EXAMPLES:
When formatted as Currency, the number 9.27 will appear as $9.27.
When formatted as Fraction, the number 9.27 will appear as 9 1/4.

6.4.1 Formatting Numbers: Toolbar Option 

When you want to format numbers quickly, Excel allows you to do so from the Ribbon.

1. Select the cell(s) you want to format

2. From the Home command tab, in the Number group, click the desired toolbar option 

	Name
	Image
	Description

	Number Format 
	[image: image76.png]General





	Displays the formatting style of the selected cell

	Accounting Number Format 
	[image: image77.png]



	Changes the formatting to Accounting
NOTE: You can insert foreign currency symbols by clicking the [image: image78.png]


.

	Percentage Style 
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	Changes the formatting to Percentage

	Comma Style 
	[image: image80.png]



	Changes the formatting to include commas and two decimal places

	Increase Decimal 
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	Adds one decimal place to the selected cell 

	Decrease Decimal 
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	Removes one decimal place from the selected cell 

	Format Cells: Number 
	[image: image83.png]



	Accesses the Format Cells dialog box


6.4.2 Formatting Numbers: Ribbon Option 
The Ribbon offers a simple way to apply number formatting.

1. Select the cell(s) you want to format

2. From the Home command tab, in the Number group, click NUMBER FORMAT [image: image84.png]


 » select the desired number format
The cell is formatted.
HINTS:
The default category is General.
The number in the selected cell is previewed under the format label in the pull-down list.

6.4.3 Formatting Numbers: Dialog Box Option 

The Format Cells dialog box can help you customize your number formatting.

1. Select the cell(s) you want to format

2. In the Home command tab, in the Number group, click FORMAT CELLS: NUMBER[image: image85.png]



The Format Cells dialog box appears with the Number tab displayed.

3. From the Category list, select the desired number format
HINT: You can preview the formatting in the Sample section.
EXAMPLE: Select Currency.
4. If the format offers additional options, select the preferred options
EXAMPLE: Format the number of decimal places, the desired symbol, and negative numbers.
[image: image86.png]Format Cells [21x]

(it || gt | Fore | sorder | F0 | protecten |

Cotegory:

] psampe—————————————————————
w2

Decinalplaces: =

symbot: 5 =

Negative numbers:

51,234, 10
(41,234.10)
(51,234.10)

=

Currency formats are used for general manetary valuss. Use Accounting Formats t
algn decimal poirts n a courn.





5. Click OK
The selected cells are formatted.

6.4.4 Clearing Number Formatting 

The General number format is the default selection. Changing the formatting to General will remove all other number formatting for the selected cells.

1. Select the cell(s) you want to format

2. From the Home command tab, in the Number group, click NUMBER FORMAT [image: image87.png]


 » select General
The formatting is cleared.

7. Functions
Basic worksheets in Excel often require you to use formulas and functions, which are calculations based on designated values, cell references, and commands. Functions are pre-written commands provided by Excel, while formulas are written entirely by the user. While both methods are useful, functions often save time and energy when working with complex but common tasks (such as finding the sum or average of a group of numbers) by allowing you to customize a pre-created calculation instead of typing it yourself.
7.1 Parts of a Function 

Functions have two basic parts which you should be aware of: 

· An equation, which is provided by Excel when you select the desired function

· Values or cell references to be used in the equation, which you will provide 

Functions that are inserted using the Insert Function dialog box or the Point and Click method provide empty equations, but you must still provide the values which will be used in the calculation. Depending on the calculation, you may choose to use several types of operands.

NOTE: While typing cell references, keep in mind that the calculations will be done using the values present in the particular cells entered, not with the cell references themselves. 
	Operand
	Example
	Value

	Cell Reference 
	A1
	Calculates the function using the value(s) present in a specified cell. References can be relative or absolute 

	Cell Range 
	A1:A3
	Calculates the function using the values present in all cells between the cells specified. References can be relative or absolute (See 7.3 Cell References: Relative and Absolute).

	Named Cell Range 
	Quiz Scores 
	Calculates the function using a specific group of cells that you have previously named. If the function is copied or moved, it will still use the values present in the specified range. 

	Value
	5
	Calculates the function using a specific value provided by you. 


There are multiple ways to create a function. You can insert functions manually (by typing them), or you can use the Insert Function dialog box. The Insert Function dialog box eliminates the possibility of a typing error, so it is the recommended method.

7.1.1 Inserting Functions with the Insert Function Dialog Box

The Insert Function dialog box makes it easy to determine what functions are available, which function you should be using, and what you need to include in the function. It displays a listing of all functions or categories of functions available with Excel. As you select a function, a sample of the function appears at the bottom of the dialog box. As you make your selection, the Insert Function dialog box will request certain types of information; you will simply need to select the cells where that information is located.

1. Select the cell where the function should be added 

2. From the Ribbon, select the Formulas command tab 
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In the Function Library group, click FUNCTION WIZARD[image: image88.png]Jfe
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The Insert Function dialog box appears. 
4. From the Or select a category pull-down list, select the appropriate function category 
OR
Select All 

5. From the Select a function scroll box, select the desired function
HINT: A description of the selected function appears beneath the Select a function scroll box. 

6. Click OK 
The Function Arguments dialog box appears. 
NOTES: 
The appearance and options available in the Function Arguments dialog box will differ depending on which function has been chosen. 
A function's arguments are the value(s) that the function is being performed upon. 
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7. In the text boxes, type the data to be used in the function
OR 
To select cell ranges 

a. Click COLLAPSE DIALOG[image: image90.png]



b. Click and drag the mouse to select the desired cells

c. Click RESTORE DIALOG[image: image91.png]



8. Click OK 
The results of the function appear in the selected cell. 

7.1.2 Inserting Functions from a Category: on the Ribbon 

Excel provides a multitude of functions for your use. While this ensures that functions exist for most of your needs, it can also make it very difficult to find a particular function. To make functions easier to find, they are divided into categories (e.g., math and trig functions, date and time functions, logic functions, etc.). If you are looking for a function that belongs in a particular category, you can access the Function Arguments dialog box from that category.
1. Select the cell where the function should be added 

2. From the Ribbon, select the Formulas command tab 

3. In the Function Library group, click the correct category » select the desired function
The Function Arguments dialog box appears. 
NOTES: 
The appearance and options available in the Function Arguments dialog box will differ depending on which function has been chosen. 
A function's arguments are the value(s) that the function is being performed upon.
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4. In the text boxes, type the data to be used in the function
OR 
To select cell ranges 

a. Click COLLAPSE DIALOG[image: image93.png]



b. Click and drag the mouse to select the desired cells

c. Click RESTORE DIALOG[image: image94.png]



5. Click OK 
The results of the function appear in the selected cell.
7.1.3 About the Function Arguments Dialog Box

The Function Arguments dialog box helps you to create functions. As you type information about the function, the Function Arguments dialog box displays the name of the function, the function arguments (i.e., the values that the function is being performed upon), a description of the function and its logic, and the result of the function. Once you have entered a function, you can further edit it using the Function Arguments dialog box.

7.1.4 To access the Function Arguments dialog box:

1. Select a cell containing a function

2. On the Formula bar, click FUNCTION WIZARD[image: image95.png]f




The Function Arguments dialog box appears.
7.2 Inserting Functions with the Point and Click Method

Functions based on cell references can be created by clicking the cells rather than typing the cell entries. This "point and click" method can help reduce the chance of error in the functions and may be easier for some users.
The key to the point and click method is to click the cells to be included and type the operators where appropriate.

NOTE: All functions that can be accessed from the Insert Function dialog box can be typed with a text-based command. If you choose to type your function into a cell, however, be sure that you know precisely how to enter information for the function, especially if you are working with a complex function. 

The following examples provide step-by-step instructions for a simple addition of two cells and for adding a range of cells.

7.2.1 Adding Cells Together
1. Select the cell where the results should be displayed 

2. To start the function, press [=] 

3. Click the first cell to be added

4. Press [+] 

5. Click the next cell to be added

6. Repeat steps 4–5 as necessary

7. Press [Enter]
The sum appears in the selected cell. 

7.2.2 Adding a Range of Cells with the SUM Function
1. Select the cell where the results should be displayed 

2. To start the function, press [=] 

3. Type SUM( 

4. Click and drag the mouse over the range of cells to be added 
OR 

a. Click the first cell in the range to be added 

b. Press [:] 

c. Click the last cell in the range to be added 

5. Type ) 

6. Press [Enter]
The sum appears in the selected cell. 

7.3 Cell References: Relative and Absolute 

Cell references are an important part of creating formulas in Excel. Using cell references allows your formulas to update automatically if the value in a particular cell changes, but using cell references properly can also assist you in updating formulas as cells are copied or moved. There are two basic types of cell references, each serving a different purpose. 

· Relative cell references 
References that will change in relation to the new location of the formula. Relative references identify cells based on their relationship to the cell containing the reference.
EXAMPLE: If you copied a formula from column A to column B and the formula contained a relative cell reference to cell A12, the formula would change to refer to cell B12.

· Absolute cell references 
References that remain the same when a formula is copied to a new location. No matter where the formula or the values in the original cell are moved, the formula will continue to refer to the same cell. 
EXAMPLE: If a formula using an absolute cell reference to cell A12 was copied to another column, the cell reference to A12 would remain constant.

Relative and absolute cell references can be used in all situations that require cell references, including cell ranges and formulas.

A formula, cell range, or cell reference can have both relative and absolute components. By adding a dollar sign ($) before either the column or row location or both, that reference becomes absolute. When adding dollar signs to cell references, only the portion of the reference directly following the dollar sign is absolute. To keep the entire cell reference constant, place a dollar sign before both the column and row location.

EXAMPLE: $A$12 

To make a cell reference absolute:

1. Within the formula, before the part of the reference (i.e., row or column reference) that you would like to be absolute, type $ 
OR
In the Formula bar 

a. Click within the cell reference you want to change

b. Press [F4] 
Part of your cell reference is changed.
HINT: Pressing [F4] will cause elements (i.e., row and column references) of your cell reference to toggle between being relative and absolute. If you do not get the desired reference the first time, continue pressing this key until the desired portions of your reference are relative and absolute. 
EXAMPLE: When pressing [F4], your cell reference may cycle through the following progression: A12, $A$12, A$12, $A12, A12. 

8. Customizing Page Layout

In order to fit information on a page or change the appearance of a page, you may want to customize your page layout. Several different aspects of your page layout may be altered to customize the way your printed worksheet appears, including: changing the orientation, changing the paper size, adjusting the scale, adjusting the margins and centering the worksheet on the page.

8.1 Changing the Orientation
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Most documents are portrait (tall) oriented, but many worksheets may be easier to read with a landscape (wide) orientation. In addition, changing the orientation can also help you fit a large worksheet onto one sheet of paper. After changing the orientation, you may need to change the paper size.

1. From the Ribbon, select the Page Layout command tab

2. In the Page Setup group, click ORIENTATION » select the desired orientation (i.e., Portrait or Landscape)
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8.2 Changing the Paper Size

The default paper size is 8 1/2" x 11", but you can select other available paper sizes, such as legal (8.5" x 14"). To select a different paper size: 

1. From the Ribbon, select the Page Layout command tab

2. In the Page Setup group, click SIZE » select the desired paper size

8.3 Adjusting the Scale

The scaling option allows you to adjust the size of the printed copy. The default size of the printed copy is 100%. You can adjust the scale to a percentage of the default size, or choose to fit the worksheet to a specific number of pages; both allow you to reduce or enlarge the entire worksheet. These options are described below.

8.3.1 Adjusting the Scale: Percentage
1. From the Ribbon, select the Page Layout command tab

2. From the Scale to Fit group, in the Scale text box, type the appropriate percentage
OR
With the nudge buttons, click the appropriate percentage 
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8.3.2 Adjusting the Scale: Fit to Page

Excel allows you to set a maximum number of pages for your worksheet to fit within. You may choose to re-scale your worksheet either horizontally, vertically, or both in order to make it fit within this set number of pages. 

1. From the Ribbon, select the Page Layout command tab

2. To rescale your worksheet horizontally within a page limit, in the Scale to Fit group, in the Width text box, type the appropriate number of pages
OR
In the Scale to Fit group, in the Width text box, click the[image: image97.png]


» select the desired number of pages 

3. To rescale your worksheet vertically within a page limit, in the Scale to Fit group, in the Height text box, type the appropriate number of pages
OR
In the Scale to Fit group, in the Height text box, click the[image: image98.png]


» select the desired number of pages 



8.4 Adjusting the Margins
1. From the Ribbon, select the Page Layout command tab

2. In the Page Setup group, click MARGINS[image: image99.png]Margins




The Margins pull-down list appears.

3. From the Margins pull-down list, select the desired option
OR
For custom margin settings 

a. From the Margins pull-down list, select Custom Margins... 
The Page Setup dialog box appears, with the Margins tab selected. 

b. In the Top, Bottom, Left, or Right text boxes, type the appropriate margins
OR 
With the nudge buttons, select the appropriate value 

c. Click OK 

8.4.1 Adjusting the Header and Footer Margins 
1. From the Ribbon, select the Page Layout command tab

2. In the Page Setup group, click MARGINS[image: image100.png]Margins



» select Custom Margins...
The Page Setup dialog box appears, with the Margins tab selected. 

3. In the Header and Footer text boxes, type the appropriate margins
OR 
With the nudge buttons, select the appropriate value 

4. Click OK
8.5 Centering the Worksheet on the Page 
1. From the Ribbon, select the Page Layout command tab

2. In the Page Setup group, click MARGINS[image: image101.png]Margins



» select Custom Margins...
The Page Setup dialog box appears, with the Margins tab selected.

3. To center within the left and right margins, in the Center on page section, select Horizontally
4. To center within the top and bottom margins, in the Center on page section, select Vertically
5. Click OK
9. Printing Basics

When printing in Excel 2007, you can print all or part of the current workbook or worksheet. 

9.1 Printing Tips

· To verify how the printout will look, use Print Preview. 

· For wide worksheets, you may want to print the information in landscape orientation (11" x 8.5") rather than portrait orientation (8.5" x 11").

· The Page Setup dialog box lets you modify various document properties, such as footers and headers, page alignment, and more. For more information, refer to 9.13 Page Setup Dialog Box on page 40.
· WARNING: If you click QUICK PRINT[image: image102.png]


on the Quick Access toolbar, your document prints without letting you customize settings in the Print dialog box.

9.2 Printing the Active Worksheet(s)

Excel lets you print the active sheet(s) in your workbook without having to print the rest of the workbook. Unless you select multiple worksheets, the active worksheet is the visible worksheet (i.e., the top worksheet; the worksheet whose tab is selected). As explained below, however, it is possible to activate specific multiple worksheets for printing. 

1. To activate the worksheet you want printed, click the tab of that worksheet
The worksheet is active.

2. OPTIONAL: To make more than one worksheet active 

a. Click the tab of the first sheet you want to activate
The worksheet is active.

b. To activate sheets adjacent to the first one you selected, press [Shift] while you click the tab of the last sheet you want selected
All sheets between the first and last tabs selected are active.
To activate sheets that are not adjacent to the first one you selected, press [Ctrl] while you click the tabs of all sheets you want selected
All selected sheets are active.

3. In the top left corner of the Excel window, click the OFFICE BUTTON[image: image103.png]


» select Print
OR
Press [Ctrl] + [P] 
The Print dialog box appears.

4. In the Print what section, select Active sheet(s)
5. Click PRINT 
The active worksheets are printed. 

9.3 Printing the Entire Workbook

Printing the entire workbook will print all worksheets that contain data. 

1. In the top left corner of the Excel window, click the OFFICE BUTTON[image: image104.png]


» select Print
OR
Press [Ctrl] + [P] 
The Print dialog box appears.

2. In the Print what section, select Entire workbook
3. Click PRINT
The entire workbook is printed. 

9.4 Defining the Print Area

By default, Excel prints all data on the current worksheet. However, you can define a specific print area from the Page Setup dialog box or the Print Area command.

9.4.1 Defining the Print Area: Dialog Box Option 

HINT: For more information about the Page Setup dialog box Sheet tab options, refer to 9.14.4 Page Setup Dialog Box Tabs: Sheet.
 

1. Select the Page Layout command tab

2. In the Page Setup group, click PAGE SETUP[image: image105.png]



The Page Setup dialog box appears.

3. Select the Sheet tab

4. In the Print Area text box, type the range of cells you want to print
OR
To select the area 

. Click COLLAPSE DIALOG[image: image106.png]



a. Select the desired range of cells
b. Click RESTORE DIALOG[image: image107.png]



a. Click OK
The print area is defined. 

 

9.4.2 Defining the Print Area: Print Area Option

Excel will keep the print area you have defined until it is cleared or replaced.

9.4.3 To set the print area:
1. Select the range of cells you want to print

2. Select the Page Layout command tab

3. In the Page Setup group, click PRINT AREA [image: image108.png]Print
Area~



 » select Set Print Area
The print area is set. 

4. OPTIONAL: To add more data to the print area 

a. select a range of cells

b. In the Page Setup group, click PRINT AREA [image: image109.png]Print
Area~



 » select Add to Print Area
The selected cells are added to any previously selected data. 

c. Repeat steps a–b as necessary

9.4.4 To clear the print area:

1. In the Page Setup group, click PRINT AREA [image: image110.png]Print
Area~



 » select Clear Print Area
Any print area settings are cleared. 

9.5 Printing Ranges of Cells

You can manually select ranges of cells for printing. You also have the option of selecting multiple non-contiguous ranges for printing.

NOTE: Unless you provide a print range, Excel will print everything on the current worksheet, resulting in a printout of all cells from A1 to the last column and row containing information.

9.5.1 Selecting a Print Range Manually
1. Select the range of cells to be printed 
OR
From the Name Box pull-down list, select the range name to be printed 

2. In the top left corner of the Excel window, click the OFFICE BUTTON[image: image111.png]


» select Print
OR
Press [Ctrl] + [P] 
The Print dialog box appears.

3. In the Print what section, select Selection
4. Click OK 
The specified range of cells is printed. 

9.5.2 Selecting Multiple Ranges

Excel lets you print non-contiguous ranges. Selected ranges will print on separate pages. 

1. Select the first range to be printed

2. Press [Ctrl] + select the second range to be printed 

3. For each additional range to be printed, repeat step 2 

4. In the top left corner of the Excel window, click the OFFICE BUTTON[image: image112.png]


» select Print
OR
Press [Ctrl] + [P] 
The Print dialog box appears.

5. In the Print what section, select Selection
6. Click PRINT 
The specified range of cells is printed. 

9.6 Printing Worksheet Groups

If you have multiple sheets in your workbook and you want to print select worksheets, you can do this using worksheet groups. This method will print the active area of each sheet (A1 to the last column and row containing information) or the assigned print area. This may result in different ranges being printed for each sheet. 

1. Group the worksheets (see 2.7 Grouping Worksheets)
2. Click the OFFICE BUTTON [image: image113.png]


 » select Print
The Print dialog box appears. 

3. In the Print what section, select Active sheet(s)
4. Adjust print settings as necessary 

5. Click OK
The selected worksheets are printed. 

6. Ungroup the worksheets (see 2.8 Ungrouping Worksheetson page 9)

9.7 Adding Headers and Footers 

Headers and footers can be useful tools for organizing and identifying a document. A header is a section of information that is printed above the body of the document, and a footer is a section of information that is printed below the body of the document. Information in headers and footers is often static throughout a document (e.g., identifying the name of the document or supplying a page number).You may choose to add a preset header or footer to your document, or to create a custom header and footer. 
9.8 Using Preset Headers and Footers

Preset headers and footers are provided by Microsoft, or can be taken from documents you have used in the past. 


1. From the Ribbon, select the Page Layout command tab 

2. In the Page Setup group, click PAGE SETUP[image: image114.png]



The Page Setup dialog box appears. 

3. Select the Header/Footer tab
The Page Setup dialog box refreshes to display the Header/Footer options. 

4. From the Header or Footer pull-down list, select a preset header or footer

5. Click OK 
The header or footer is applied to the document.
NOTE: The header or footer may display the header or footer code (see 9.10 Header and Footer Elements below) on your screen, but the text will be visible when the worksheet is printed.
9.9 Creating Custom Headers and Footers

You may want to create your own headers or footers. You can adjust the font face and the size, add your own text, and add text that will be automatically updated with your document. Custom headers and footers may be added in two ways: using the Ribbon or the Header and Footer dialog boxes. 

9.9.1 Adding a Custom Header or Footer: Ribbon Option
1. From the Ribbon, select the Insert command tab 

2. In the Text group, click HEADER & FOOTER[image: image115.png]] Header & Footer



 
A header appears, divided into three sections, and the Design command tab is visible on the Ribbon. 
HINT: One section of the header appears on the left of the top margin, one in the center, and one on the right. Although all three sections may not be visible, clicking in one of these areas will cause that section to appear. 
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3. OPTIONAL: To work with a footer, in the Navigation section, click GO TO FOOTER [image: image117.png]


 
NOTE: The footer, like the header, is divided into three sections. Although all three may not be visible, clicking in one of these areas will cause that section to appear. 

4. Click the section of the header or footer where you want to add content

5. Type or use the Header & Footer Elements to add all desired information 

6. OPTIONAL: To change the formatting of your text 

a. Select the text that you want to format 

b. From the Ribbon, select the Home command tab

c. Using the commands in the Font group, make all desired formatting changes 

7. To stop working with your header or footer, click outside of it 
NOTE: The header or footer may display the header or footer code on your screen, but the text will be visible when the worksheet is printed.

9.9.2 Adding a Custom Header or Footer: Dialog Box Option 
1. From the Ribbon, select the Page Layout command tab 

2. In the Page Setup group, click PAGE SETUP[image: image118.png]



The Page Setup dialog box appears. 

3. Select the Header/Footer tab

4. Click CUSTOM HEADER... or CUSTOM FOOTER...
The Header or Footer dialog box appears, respectively.

5. In the Left section, Center section, and Right section text boxes, type or use the Header & Footer Elements (see below) to insert the desired information in each section of your header or footer 

6. OPTIONAL: To change the formatting of your text 

a. Select the text you want to format

b. Click FORMAT TEXT[image: image119.png]



The Font dialog box appears.

c. Select the desired options

d. Click OK 
The Font dialog box closes. 

7. When finished, click OK
The Header or Footer dialog box closes. 

8. Click OK 
The Page Setup dialog box closes. 
NOTES: 
If you created a header with multiple lines, it may overlap with the information on the spreadsheet.  
To ensure that your header with multiple lines is displaying properly, refer to Adjusting Margins. 
The header or footer may display the header or footer code on your screen, but the text will be visible when the worksheet is printed.
9.10 Header and Footer Elements 

Excel allows you to create custom headers and footers by either typing your own text or adding specific text fields. The buttons available in the Header & Footer elements group provide you with text fields that will automatically update the information displayed as your document changes. These elements can also be added to preset headers and footers to customize your document. 

The Code column in the table below shows the command that Excel will insert when the option is selected. 


Although you may see only the code when looking at your document, the code will be translated to the corresponding information when the sheet is printed.

NOTES:  If you choose to create a custom header or footer using the dialog box option, note that these buttons are also available in the Header and Footer dialog boxes. However, only the graphic part of the button will be visible in these dialog boxes.

	Button
	Code
	Action
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	&[Page]
	Inserts the page number
NOTE: Excel will count only the pages that have data in at least one cell. 
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	&[Pages]
	Inserts the total number of pages
NOTE: Excel will count only the pages that have data in at least one cell. 
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	&[Date]
	Inserts the current date

	[image: image123.png]Current
Time.




	&[Time]
	Inserts the current time

	[image: image124.png]File
Name




	&[File]
	Inserts the filename of the workbook

	[image: image125.png]Sheet
Name




	&[Tab]
	Inserts the name of the current worksheet

	[image: image126.png]File
Path




	&[Path]&[File]
	Inserts the path and filename
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	&[Picture]
	Displays the Insert Picture dialog box so you can insert a picture
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	None
	Displays the Format Picture dialog box so you can adjust picture properties
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	None
	Available only in the Header and Footer dialog boxes; displays the Font text box to adjust text formatting


9.11 Adjusting Margins

You may want to check your custom header or footer to ensure that it will print properly. If there are problems with the display of your header or footer, you may be able to fix them by adjusting the margins. You can adjust the margins in two ways: using the mouse option or the dialog box option. 

9.11.1 Adjusting Margins: With the Mouse 

1. From the Office Button menu[image: image130.png]


, select Print » Print Preview 
Your document is displayed in Print Preview mode.

2. In the Preview group, select Show Margins
The margin outlines appear. 
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3. Using the mouse, click and drag the margin outlines to the desired position 
NOTE: The uppermost and bottommost margins are for the header and footer, respectively.

4. Click CLOSE PRINT PREVIEW[image: image132.png]Close print
-y




Excel returns to the work area. 

9.11.2 Adjusting Margins: With the Page Setup Dialog Box
1. From the Office Button menu[image: image133.png]


, select Print » Print Preview 
Your document is displayed in Print Preview mode.

2. In the Print group, click PAGE SETUP[image: image134.png]Page
R




The Page Setup dialog box appears.

3. Select the Margins tab
The Page Setup dialog box refreshes to display the Margins options. 

4. In the Top, Left, Right, Bottom, Header, and/or Footer text boxes, type the preferred margin size
OR
Use the nudge buttons to adjust the margins

5. Click OK
The Page Setup dialog box closes. 

6. Click CLOSE PRINT PREVIEW[image: image135.png]Close print
-y




Excel returns to the work area. 

9.12 Printing Gridlines

Gridlines (outlines of each cell) will not print by default in Excel 2007, and can be helpful in printed documents. 

1. From Ribbon, select the Page Layout tab

2. In the Sheet Options group, in the Gridlines section, select Print 
3. Print your document 

9.13 Page Setup Dialog Box

In addition to the Print dialog box, the Page Setup dialog box provides many options to help you print your Excel worksheets. 

9.13.1 Accessing the Page Setup Dialog Box
1. From the Page Layout command tab, in the Page Setup group, click PAGE SETUP[image: image136.png]



The Page Setup dialog box appears.

9.14 Page Setup Dialog Box Tabs 

The Page Setup dialog box consists of four tabs: Page, Margins, Header/Footer, and Sheet. Each tab lets you customize elements of your Excel worksheet. For additional information, refer to 8. Customizing Page Layout.
NOTES: The following buttons are found on all tabs: PRINT... (opens the Print dialog box), PRINT PREVIEW (opens Print Preview), OPTIONS... (opens the (printer name) on print Properties dialog box), OK, and CANCEL. If you accessed the Page Setup dialog box differently than as described in Accessing the Page Setup Dialog Box, the PRINT... and PRINT PREVIEW buttons may not appear.

9.14.1 Page Setup Dialog Box Tabs: Page 

The Page tab offers several options to help you specify how your worksheet(s) will print.
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	Option
	Description

	Orientation
	Determines if your document prints as a portrait (i.e., lengthwise) or as a landscape (i.e., widthwise)

	Scaling
	Adjust to lets you to customize page scale by percentage. Fit to lets you specify how many pages it takes to print your worksheet
HINT: Print Preview lets you see the effects of scaling before you print. 

	Paper size
	Determines what size paper you will print on 

	Print quality
	Determines resolution

	First page number
	Indicates what number appears on the first printed page. If you want the first page number to be 1, leave the selection as Auto



9.14.2 Page Setup Dialog Box Tabs: Margins 

The Margins tab lets you set your margins and center your data vertically, horizontally, or both.

NOTE: All margin values are measured in inches.
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9.14.3 Page Setup Dialog Box Tabs: Header/Footer

Headers and footers are the text printed at the top and bottom of pages, such as the date, page number, the filename, or other text. The Header/Footer tab provides options to customize page headers or footers. For more information about headers and footers, refer to 9.7 Adding Headers and Footers.
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	Option
	Description

	Header
	Provides several pre-written headers

	Footer
	Provides several pre-written footers

	Custom Header...
	Lets you create your own header using the Header dialog box. For more information, refer to 9.7 Adding Headers and Footers.

	Custom Footer...
	Lets you create your own footer using the Footer dialog box. For more information, refer to 9.7 Adding Headers and Footers.

	Different odd and even pages 
	Lets you create different headers or footers for odd and even pages 

	Different first page 
	Lets you create a different header or footer for only the first page

	Scale with document 
	Adjusts the header and footer font and scaling to match the rest of the document

	Align with page margins 
	Sets headers and footers within the page margins



9.14.4 Page Setup Dialog Box Tabs: Sheet

The Sheet tab gives you several options for determining which elements of your workbook are printed.
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	Option
	Description

	Print area
	Specifies a range of cells to print

	Print titles
	Specifies the rows or columns to print on each page. These rows or columns are likely to be the headings that define what the rest of the row or column's information is used for

	Print
	Allows you to print only certain elements of your worksheet.

	Page order
	Sets the order in which worksheet pages are numbered and printed


Appendix A: Pointer Shapes
As with other Microsoft programs, the pointer often changes its shape as you work in Excel. Each pointer shape indicates a different mode of operation. This document provides a table describing the various pointer shapes you may see while working in Excel 2007. 
	Shape
	Context
	Action
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	The default pointer shape; appears in most Excel workspace contexts 
	Moves cell pointer or selects a range of cells
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	Appears when the pointer is on the border of a window 
	Adjusts window size 
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	Appears when the pointer is between a row or column divider 
	Adjusts height and width of rows and columns 
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	Appears when you are editing cell contents
	Provides a text insertion point
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	Appears when the pointer is on a column or row heading
	Selects columns or rows 
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	Appears when the pointer is placed over a cell border, graphic, or other object
	Moves cells, graphics, or objects 
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	Appears when the pointer is on the "fill corner" of a cell or cell range
	AutoFills other cells with similar information
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	Appears when mouse is placed over the Ribbon
	The standard Microsoft Windows pointer; selects Ribbon and menu options


Appendix B: Worksheet Terms

Like all other areas of computer technology, Microsoft Excel worksheets have their own "language." This list of common terms is provided to serve as a reference for you as you work in Excel.

Cell
The intersection of a column and row. Information is stored in cells.

Cell Pointer
The cell pointer is similar to Word's insertion point. It selects or marks the current cell (where the next activity is going to take place). The Excel pointer changes shape depending on location and corresponding function. For more information, refer to Pointer Shapes above. 

Cell References
The address, consisting of the column and row IDs, of a specific cell. The current cell location is displayed in the upper left corner of the worksheet. 

Column
A vertical group of cells within a worksheet.

Formula
A set of instructions which perform a calculation based on numbers entered in the cell or numbers entered in other cells (referred to by cell references). All formulas begin with the equal sign (=). 

Function
A pre-programmed formula. The function performs the calculation based on the cells referenced in the function. All functions begin with the equal sign (=).

Range
A group of cells. Ranges are often referenced for formulas, printing, and designating information to be copied or cut. Ranges can be selected by clicking and dragging over the cells. 

Row
A horizontal group of cells within a worksheet.

Value
A number that can be used in an Excel calculation.

Workbook
A collection of worksheets contained within a single file.

Worksheet
A single layer or single sheet within the workbook. A worksheet can contain data, charts, or both. Instead of compiling all of your information into one worksheet, you can create several worksheets within the one workbook file. With this organization, similar information is grouped together to make it easier to locate and use. The worksheets for your workbook will vary based on its content and purpose.
EXAMPLE: If you want one file containing the grade books for all sections you teach, each section can be on a separate sheet. 
NOTE: The terms worksheet and spreadsheet are often used interchangeably.
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